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Welcome to Pro-Stitcher Catalog
Pro-Stitcher Catalog gives you the ability to quickly sort and find digital designs in your computer. This 
simple-to-use software allows you to add or edit notes, add keywords, and give ratings to saved quilting 
designs, enabling you to easily find the perfect design for your next quilting project.

You can even customize how you organize and find your designs with Pro-Stitcher Catalog. Creating a 
collection by using keywords or ratings is straightforward and uncomplicated, allowing you to effortlessly 
find and use exactly the design you searched for.

The user interface of Pro-Stitcher Catalog makes it simple to learn and use. Lifetime program updates are 
always included for free. The user manual, tutorials, and videos are all easily accessible from the software 
itself or by visiting www.ProStitcher.com.

Organizing and finding your quilting designs has never been so easy. You’ll always have the perfect design 
for your next quilt at your fingertips!

Software System Requirements
Minimum System Requirements

Windows 8 – 8.1; 1 gigahertz (GHz) or faster processor with support for PAE, NX, and SSE2; 1 gigabyte 
(GB) (32-bit) or 2 GB (64-bit) RAM; 16 GB or 20 GB (64-bit) hard disk space; Microsoft DirectX9 graphics 
device with WDDM drive; USB port; 800 x 600 display; mouse, internet access.
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There are two ways to purchase PS Catalog.

Purchase Option 1
If you already own PS Designer, update your software 
to version 15.39 or later. Once the update is complete, 
there will be a new shopping cart icon tab added to the 
View window in the bottom right of your design page. 
Click on the Purchases tab, then follow the instructions 
below:   

1.  �To purchase PS Catalog from a computer with internet 
connection, click on the shopping cart icon below the 
View window panel to open View Purchases. 

2.  �Click on the box with the three dots at the right 
side of the PS Catalog bar to go to the Pro-Stitcher 
Designer web page.

3.  From the dropdown menu, select Buy Now.

2

1

3

4.  Follow the prompts to purchase PS Catalog.  

5.  �When the purchase is completed, a confirmation email will be sent with the PS Catalog serial number.

Skip ahead to the Register PS Catalog section.

Purchase Option 2 

	� ONLINE: To purchase PS Catalog without Pro-Stitcher Studio/PS Designer, visit the website  
https://prostitcher.com/pro-stitcher-catalog/

How to Purchase PS Catalog
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How to Install PS Catalog
On a computer with internet access, open the purchase confirmation email received after purchasing 
Pro-Stitcher Catalog. Click on the link in the Download column titled “Pro-Stitcher Catalog.” The software 
will save to the Downloads folder of the computer’s C: drive. 

1.  Open Windows File Explorer and select the Downloads folder. 

	 •  �To install on the computer, double-click on the PSDSetup file to launch the InstallShield Wizard.

	 •  �To install on a tablet without internet connection, copy and paste the file to a USB drive. Take the 
drive to your tablet, insert in the USB port and proceed with the installation instructions. 

	� NOTE: Windows may generate a message asking “Do you want to allow this app to make changes to 
your device?” Select Yes to proceed with installation. 

2.  �The Pro-Stitcher Studio – InstallShield Wizard will launch. Select Next. 
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3.  Click “I accept the terms in the license agreement” then click Next.

4. On the next screen, click Install. The InstallShield Wizard will run the installation.

5. Click Finish to complete the installation.
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How to Register PS Catalog
Option 1: Register PS Catalog on a Computer or Tablet with Internet Connection

1.  �Locate the PS Studio icon on the Destktop. Double-click on the icon to launch the software.  

2.  �When the PS Designer landing page appears, click on the X in the top right corner of the screen to close 
the window. 

3.  �The View windowpane on the lower right side of the screen will have a Purchases tab with a shopping 
cart icon. Click on the shopping cart to open the Purchase menu and display the available  
Pro-Stitcher Studio modules.  

4.  �Click the box with 3 dots on the right side of the Pro-Stitcher Catalog bar. A drop-down menu will load.  
Select Activate.  
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5.  The Welcome screen will load.

6.  �Fill in all of the required boxes. Fill in the serial number provided in the purchase  
confirmation email. Remember the serial number is case sensitive (turn on your caps lock) and include 
the dashes. 

 
7.  �The Register Now button becomes active once all the fields are correctly populated. Click Register Now 

to register your software. 

	� NOTE: A registration number is already populated, and since the device is connected to the 
internet, there is no need enter an activation number. It will populate after the Register Now button 
is clicked. 

8. A message will load, prompting you to restart the Application. Click OK. 

9. From the Pro-Stitcher Studio window select the File tab, then Exit from the drop-down menu. 

10. Installation is now complete.
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Option 2: �Register PS Catalog as a Stand-Alone Component on a Computer or 
Tablet with Internet Connection

1.  Locate the PS Studio icon on your Destktop. Double-click on the icon to launch the software.  

 

2.  The Welcome screen will load.

3.  Select Pro-Stitcher Catalog from the drop-down menu. 

4.  �Fill in all of the required boxes. Fill in the serial number received in the email confirming your purchase. 
Remember that the serial number is case sensitive (turn on caps lock) and include the dashes.
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5.  �The Register Now button becomes active once all the fields are correctly populated. Click Register Now 
to register your software. 

	� NOTE: A registration number is already populated, and since the device is connected to the 
internet, there is no need enter an activation number. It will populate after the Register Now button 
is clicked. 

6.  A message will load prompting you to restart the Application. Click OK.

7.  �Select the File tab on the Pro-Stitcher Studio Window, then Exit from the drop-down menu. 

8. Installation is now complete.
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Option 3: �Register PS Catalog on a Computer or Tablet without an Internet 
Connection

If registering on a device with no internet connection (such as a Pro-Stitcher tablet) follow the procedures 
outlined above in Register Your Software Option 1 through Step 5, when you get to the Welcome screen. 
Proceed with the following steps to obtain an activation number: 

1.  �Fill in all the required boxes. Fill in the serial number received in the purchase confirmation email. 
Remember the serial number is case sensitive (turn on caps lock) and include the dashes.

2.  �Write down the Registration Number (this number auto-populates with a different number each time 
the software is launched until it is registered.)

3.  DO NOT TURN OFF YOUR TABLET.

4.  Go to a computer that has internet connection. 
	 • Open a web browser, and go to http://www.esoftwareondemand.com/ProductRegistration.aspx 

5.  �Fill in all of the boxes with asterisks by them. Fill in the serial number you received in the purchase  
confirmation email.  Remember the serial number is case sensitive (turn on caps lock) and include  
the dashes. 

6.  �Fill in the Validation Code with the Registration Number from step 2. Remember the Validation Code is 
case sensitive (turn on your caps lock) and include the dashes. 

7.  Click on the Submit button at the bottom of the screen.

8.  An Activation Code will populate in the gold box at the bottom. 

9.  Write down the Activation Code.

10.  �Go back to the tablet and enter the Activation code in the appropriate box. Remember the Validation 
Code is case sensitive (turn on your caps lock) and include the dashes.    



12 | ProStitcher.com

11.  �The Register Now button becomes active once all the fields are correctly populated. Click to register 
the software.

12.  A message will load prompting you to restart the Application. Click OK.

13.  �The software will open. On the Pro-Stitcher Studio screen, select the File tab, then Exit from the drop-
down menu. 

14.  Installation is now complete.

15.  On your desktop, the PS Studio icon will be added.
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How to Use PS Catalog
Search for a Design

1.  �Once installation is complete, the PS Studio icon will be added to your desktop. Launch PS Catalog by 
double-clicking on the PS Studio icon on your computer desktop.

2.  Select the Home tab. From the ribbon, select New, then Find.

	 	
			       PS Designer with PS Catalog tabs			  PS Designer with PS Catalog tabs

3.  The Find window will load to your screen.

A          �Keywords: Enter a keyword or keywords to search 
for designs. Separate key words with a comma or 
space and use the words and/or to narrow the 
search. Click on Find or press the enter key to 
display the results. The number of results will list 
in the bottom right of the Find window and the 
Designs will display in the lower portion of the 
View sidebar window. Click on the box with the 3 
dots to the right of the Find button to clear filters 
or show your Keyword list. 

      •  ��Notes: To search by notes that are included in 
the design file, enter the word you are searching 
for in the Notes field. Separate search words 
with a comma or space and use the words and/
or to narrow the search. Click Find or press the enter key to display the results. Notes often include 
designer name and website, copyright information, and nesting or spacing instructions for the design.

      •  �Name: To search by design name, enter all or part of the design name in the Name field. Separate 
search words with a comma or space and use the words and/or to narrow the search. Click Find or 
press the enter key to display the results. 

      •  �Stitches: To search for a range of total stitches in a single design, enter the minimum number of 
stitches in the From box and the maximum number of stitches in the To box. Click Find or press the 
enter key to display the results. 

      •  �Colors: To search by the number of colors used in an individual design, enter minimum number of 
colors in the From box and the maximum number of colors used in the To box. Click Find or press the 
enter key to display the results. Note: This function was designed for embroidery files and is rarely 
used for quilting designs.
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To Add or Edit Notes, Keywords, and Ratings to a Design

1.  Load a design. Deselect the design.

2.  Click the Information tab in the Designs window panel.

3.  �Most designs will already have notes which include the design name, the designer name and website, 
copyright information, and spacing or nesting information specific to the design. U.S. Copyright Law 
requires you to keep all copyright information in the notes associated with the design.

	� NOTE: Notes can be used to keep track of which designs were used on specific quilts, or to create 
categories and make it easier to quickly find designs. For example, adding the note “Uncle Bob’s 
birthday quilt” or “Best of Show 2020,” etc., makes it easier to categorize your designs. 

4.  �Enter the changes or add information to the Notes or Keyword fields. Notes can be separated by a space, 
comma, or return. Keywords can be separated by a space or comma. Click Apply to save the changes to 
the design file. A pop-up will load asking to Save Changes? Click Yes.

      •  �Width and Height: To search by width or height of a design enter the size parameters in the To and 
From boxes. Use width or height alone or together to narrow the search. Click Find or press the enter 
key to display results. 

      •  �Date: To search for a design by file date, enter a From and/or To date in the approriate boxes, then 
check the box beside each field to activate the From and/or To fields. Click Find or press the enter key 
to display results. 

      •  �Include All Formats: Select to include all quilting formats. When this box is not checked, only .c2s 
files will be searched (.c2s files are the native file format for PS Designer). 

F
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5.  �To rate a design, highlight Stars by clicking the highest star rating assigned to the design. Click Apply to 
save the rating to the design file. A pop-up will load asking to Save Changes? Click Yes.

	� NOTE: Ratings can be used to organize your design files. For example, give your most used designs a 
5-star rating to make them easy to find. 

Default Path for Designs

The default path is always C:\Designs\. This is the file that will be searched when using PS Catalog. The 
software will not search other files unless you link the file to your C:\Designs.

Add a New Link to a Folder

To add a folder located somewhere on your computer other than C:\Designs\, please follow these directions 
to add a new link to that folder, making it searchable.

1.  Select the Designs tab.

2.  Click to select the desired folder.

3.  Right click; select New Link from the pop-up menu.

4.  A browser to select target will appear.

5.  Select the folder from computer or USB to link.

6.  Click Select Folder. The folder is now linked to the selected folder.

7.  �The New Link will be added under the previously selected folder and the designs will be viewed in 
the window when selected.

8.  �To rename the link or delete the link, right click on the link folder. A dialogue box will appear; select 
the appropriate option.
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The Design View

When PS Catalog is installed, Windows File Explorer will display all supported quilting designs in ICON form.  

In Windows File Explorer: 

1.  �Navigate to C:\Designs\PS Designs\Blocks.

2.  Click on View.

3.  Click on Large Icons.

4.  Click on Details panel.

5.  Click on Bird Fill.hqv.

Print Designs

To print out the design catalog, follow these steps.

1.  Select the File tab.

2.  From the menu, select Print Catalog.

3.  A print catalog menu will load.

4.  Click on the 3 dots to the right of the Designs folder bar.

5.  �You will be able to locate and select what design folders you want to print. Select any folder, then 
click on Select Folder.

6.  �On the Print Catalog menu window, you will be able to choose if you want to include subfolders, 
how many columns of design thumbnails you want to see, if you want the folder path to print, the 
date, and page numbers.

7.  �Click on Select to open a window that will have a PDF of the designs you’d like to print. Click Save.

8.  �Your computer will open a copy of the PDF in Adobe Acrobat reader. Print out the catalog by clicking 
on the print icon at the top of the window.
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How to Add Notes, Keywords, or Ratings to All Designs in a Folder

In the Designs view window, click to select a folder.

Right click on the selected folder and then select Set Info.

Select to add information to all files within the folder. Check the boxes next to the fields where you want to 
add information.

Type in the desired information and then select OK.
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A window will load. Click Yes to save changes.

All design files within that folder will have the information added to the appropriate field in the design 
information.



1-855-777-5257
support@prostitcher.com

www.ProStitcher.com 


